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Introduction 

BioPix iQ is a program specialized in quantifications of histological tissue samples. The 

major application intended from the start was quantifications of atherosclerotic plaques, 

but a vast majority of other quantification tasks are possible.  

Due to differences in plaque morphology and artifacts in surrounding tissue between 

samples, fully automated quantifications are not possible. However, after manual selection 

of the outer border of the artery, automatic selections of plaque, lumen and vessel wall are 

possible with the automatic selection tools included with BioPix iQ. 

Major advantages with BioPix iQ are the possibility to work with several images at the same 

time, and the easy-to-use interface which allows rapid quantifications of large amount of 

samples. Furthermore, the user has interactively control of the selections/quantifications 

during the process – which highly reduces the risk for errors.  

This document describes how to install and get started with BioPix iQ. 

If you can’t find the information you are looking for, we will be happy to answer any 

questions you might have of how to successfully apply the BioPix software in your research. 
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Prerequisites 

Software Requirements 

The following software must be installed before the installation of BioPix iQ. 

¶ Microsoft Windows 2000 or XP 

¶ Microsoft .NET Framework Version 2.0 

(included in most setups for BioPix iQ) 

The .NET Framework can be downloaded from Microsoft® 

(http://www.microsoft.com/net/). 

Hardware Requirements 

To run this application, a computer with a minimum of the following specification is needed 

(the program might function with hardware that don’t match the specifications). 

¶ Pentium IV 1,2GHz or better 

¶ 512MB RAM 

¶ 500MB Free hard drive space (for temporary memory) 

Installation 

Step 1 – Start the installation program by double clicking on the file Setup BioPix iQ 2.0.exe 

Step 2 – The installation program starts. 

 

http://www.microsoft.com/net/
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Step 3 – Select the destination folder where BioPix iQ should be installed. Select whether all 

users or only the current user may use the program. 

 

Step 4 – Click on the Install button to install BioPix iQ. 

Step 5 – The last step of the installation. Click on the Finish button to complete the 

installation process. 

 

Step 6 – When installation is completed, a new program icon appears on the Start menu. To 

start the program click on the icon on the start menu; 

Start Ą Program Ą BioPix Ą BioPix iQ Ą BioPix iQ. 

Un-Installation 

In the Windows start menu, select the following 
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Start Ą Program Ą BioPix Ą BioPix iQ Ą Uninstall BioPix iQ. 
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Getting started 

Description of User Interface 

The left side contains controls for adding and removing image files for quantification. The 

files loaded are arranged in groups. On the right side, you find all the tools for selecting 

areas for quantification. 

 

1. The Details box shows details of the image or group selected in the File List. 

2. The File List where the files to work with are arranged in Groups. 

3. The Image Tools are used to make and modify the selections done on the Layers. 

4. The Auto Tools (HSB color in the image) is used to make selections that can be 

applied to all images. 

5. The different Layers used for selection of different areas in the image. 

6. The image view shows the current opened image. 

1 

2 

3 

4 

5 

6 
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Details 

The detail box displays the name and resolution for an 

image. Click the Set Resolution button to set the pixel 

resolution for an image/group. This must be done, in 

order to obtain correct information of areas, but is not 

necessary if one only wants to know ratios and 

percentages etc. 

When setting resolution for a group containing images the group resolution will not 

override the previously set resolution for individual images. 

Files 

To work with images, the first thing that must be done is 

to add images to the File List. This is done by pressing 

the button Add Files. Images can be arranged into 

groups by creating a group using the Add Group button, 

and adding the images to that group by pressing the Add files button, then selecting the 

wanted group (in the drop down list). 

The files and groups can be saved to a project which enables the user to open the project 

later and continue work. 

Files and groups can be removed from the project by using the Remove buttons. Select 

what you want to remove and click on Remove, or right click on the selected items and 

choose remove from the context menu. 

A whole folder, including subfolders, can be added using the Add Folder button. Click the 

button and choose from the dialog what files types to include. 

Image Tools 

The image tools are the main tools that are used when 

working with the images. It consists of tools that control 

the view of the image, the zoom tools, position and tools 

for drawing, erasing and filling areas of the image. 

 

  Zoom and set the view mode.  
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  Magnifying glass 

Á Left click: increase zoom 50% (Zooming in) 

Á Pressing left mouse button and dragging before releasing mouse 

button – The zoom is adjusted so the area selected is fitted to the 

view. 

Á Right click – decrease zoom 50% (Zooming out) 

Á Ctrl+Scroll Wheel to zoom in and out. The zoom tool do not have 

to be active to zoom this way. 

  Panning tool – Pan the image by pressing the left mouse button and 

dragging the mouse the way you want to pan the image. 

  One view – showing the image and all areas, 

  Split view vertical – Shows original image on one side and the image 

with marked areas on the other  

  Split view horizontal – Showing original image on top and the image 

with marked areas on bottom 

 Under View in the main menu, selecting Open new Window will open a new view 

in a new window. 

  Brush size and fixed zoom levels. 

 Brush size – Set the size of the brush. 

 Zoom drop down – A number of fixed zoom levels. ‘Zoom fit’ fits the whole 

image to the view area. 

Drawing tools 

The drawing tools are used for affecting a layer “by hand”. No 

tool can affect other layers than the active one, and therefore 

cannot draw one a spot already marked on another layer. 

 

 Pointer- The pointer does not affect the layers. Use it to set parameters for 

the image view by right-clicking and selecting an action. 
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  Line – Draw a continuous line. 

 Double click to draw line from last to first point. 

 Right click to stop drawing the line. 

   Pen – Freehand drawing on the active area with the selected brush size. 

  Eraser - Freehand erasing on the active area with the selected brush size. 

  Paint Bucket – Filling a continuous region limited by the selections of all 

areas. 

  Flag – The flag is not a drawing tool. Click on a selection in the active layer to 

view the area of this selection. This flag will be stored with the layer, and can be 

viewed later in the data output. To be able to measure a specific area e.g. nuclei of 

cells, you need to have set a resolution for your image before. Otherwise the flag 

tool cannot measure the area other than in pixels. 

 To remove all flags in a specific layer right click on that layer and click Clear 

Flags.  

 To remove all flags from the current layer click Tools/Clear Flags in Current 

Layer. 

 To remove all stored flags in the current image click Tools/Clear All Flags in 

Image. 

  Length measurement tool- Select a starting point by clicking on the left 

button on your mouse, then left click again to mark the end of your line. To end the 

measurement right-click with the mouse. Also for this tool you need to have a set 

resolution to obtain your length measurements in µm, instead of just pixels. 

 The lines can be removed from in a manner similar to how Flags are 

removed: Either by right-clicking the image in the File List, and choosing 

Measurements/Clear Flags, or from the Tools menu under Measurements. 

Auto Tools 

The tools for automatic area selections are a complement 

to the image tools. The difference is that by using the 
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suggestion tools, the program gives a suggestion of the area that should be marked. This 

marking can later be adjusted manually with the Image Tools described above. 

The automatic tools consists of the following four tools 

Select by Color 

The select by color tool selects an area in the image based 

on a chosen color. 

This is done by either clicking the color picker, followed by a 

click at the area of interest in the image, or by clicking the 

colored box and selecting a color. The sensitivity of the tool 

can then be changed with the slide to exactly find the color wanted. 

By pressing the colored square box, a custom color can be chosen. 

 

Select Region 

This tool is used to mark an isolated region in the image, 

with a unique color. 

To use this tool, click on the Select Region button and click 

on one pixel in the area that should be selected. If the area 

selected is not correct, the Undo button (or Ctrl+Z) must be 

used to undo the selection before selecting a new area. Adjusting the maximum difference 

allowed will not affect any previous selections. Click any other point in the image to add a 

new selection with the same settings. 

Not Selected 

This tool selects all pixels that have not previously been 

selected in any other layer. 

 



   

BioPix iQ 2.0 User Guide  

 

BioPix iQ User Guide / Rev 4/ 2008-06-03  13/29 

Select by HSB 

With the HSB selection tool it is possible to select areas by 

their value in hue, saturation or brightness (brightness is 

similar to what in other contexts may be called value or 

lightness). 

The upper and lower limits of each slider can be changed 

either by dragging the marker or by clicking on the 

corresponding number and entering the specific value and 

then pressing the Enter key. By pressing the mouse over 

the circle, one can shift both the upper and lower limit at the same time. 

It is also possible to set the limits so that these capture a range of values lying over the 

normal top or bottom. One could for instance want to select pixels that are very bright or 

very dark, but not in the middle. This is done by shifting the colored bar by dragging it with 

the right mouse button. 

 

By clicking the reset button, al limits are set to 0 and 1 respectively. It is also possible to 

select limits from a pixel in the image by first clicking the pipette tool and then clicking in 

the image. 

Two ways of selecting all red values, that normally lies at the edges of a bar. 

Drag upper limit pass the lower and 

the lower across the upper. 

‘Shift’ the color bar by dragging it 

with the right mouse button. 
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Color Marker 

This tool allows you to create markers in the HSB 

selection tool with bars indicating the range of color 

you want to select for a specific layer. After activating this 

tool, you can left click on the color you want to choose. If 

the color you want to select have different shades, you can 

simply just left click on the different shades in your image. 

With this you get several bars appearing in the HSB tool. 

This gives you an idea of where to move the limit bars to, for getting the best selection of 

the color of your choice.  

If there is a color you would want to avoid, just right click 

on this color and you will see bars that are turned upside 

down in the HSB tool indicating in what range the color you 

would want to avoid is in.  

 

This button opens the HSB tool in a bigger window. 

 

Applying selection to all images or to group 

The current Color or HSB selection can be automatically applied either to the same group 

as the active image, or all images. This is also possible with the Not Selected tool. This 

functionality is accessed through the Tool menu in the main menu, or by right-clicking any 

number of groups and images in the File List, and selecting for instance “!ǇǇƭȅ I{.έΦ 
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Layers 

The layers contain selections that represent different 

aspects of the image. In iQ there are seven layers. 

1. Outer – Selects areas in the image that is not of 

interest. 

2. Artifacts – Select parts of the image that should not 

be quantified. 

3. None Tissue – Select areas that are not tissue. 

4. Layer 1 – Area for layer 1. 

5. Layer 2 – Area for layer 2. 

6. Layer 3 – Area for layer 3. 

7. Layer 4 – Area for layer 4. 

Copying and Pasting Layers 

The selection on an area can be copied from by right-

clicking on the button for that layer and then choosing 

Copy. 

To paste, right-click on the button for the layer onto wishes 

to paste. By choosing Paste the copied selection will be 

superimposed upon any existing selection. By choosing 

Paste and Overwrite, any current selection on that layer 

will be erased and the layer will look just like the copied one. 

Please note that to be able to copy and paste selection, the source and target image must 

have the same size. 

Renaming a Layer 

To rename a Layer, right-click the corresponding layer button. In the text-box where the 

current name of the layer is, type the new name and press the Enter key. 

Layer Function Buttons 

  Color on the button (deep pink) indicates that this 

is the working layer. Right click the button for more options. 

 To change the color for a layer, click on the colored rectangle to 

select a new. To adjust the opacity click the + or – button. 

   Click on this button to clear the Layer. 
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Main Menu 

Here the options in the main menu are explained. 

 

 

File 

In the File Menu, the project files are handled. One 

can create a New project, Open an existing 

project, Save the current project, or save the 

current project to a new file. 

Under Recent Projects, recent opened and saved projects are listed. If the current open 

project is in the list, it is marked with a green color. If the project has a dark gray 

background, the program cannot find the specific project file. The recent projects are also 

available using shortcuts; Ctrl + F1 for the first project in the list, F2 for the second and so 

forth. After starting BioPix iQ with no program open, one can open the last opened project 

(if any) by pressing Ctrl and F1. 

 

Edit 

Undo 

To undo the last action, select undo, or press Ctrl + Z on the 

keyboard. 
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Preferences 

In the Main menu under Edit, select Preferences to access the preferences setup. Here the 

preferences of the program can be changed. 

Tools 

Here are the tools to apply the 

current Color, HSB selections to 

all images or the group, or 

select all Non Selected in all 

images or group. 

You can also set resolution for 

all images here.  

 

Measurements 

The flags and the length measurements set in an image or a layer can be removed. 

 

View 

Here the different views are available. 

You can either choose only one window 

or two, where one only shows the 

original image and two shows both 

altered and original images side by side 

horizontally or vertically. 
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Capturing Image 

To capture an image from the program, select View in the Main menu and then Capture 

Image to File. A dialog will then be displayed asking for a file name for the image file. 

Change the format of the saved file by selecting another file type, or by giving the file a 

valid extension. For instance, naming the file ‘picture1.jpg’ will save it as a JPEG file, while 

‘picture2.png’ will save it as a PNG file. 

 

Show Flags 

This options sets if the flags should be shown or not. This can also be toggled by pressing 

Ctrl + F. 
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Results 

Select Images and Data 

When the results button is clicked a dialog appears. The dialog gives the opportunity to 

select images and the type of data that should be calculated. 

Selection of images 

All images that area marked as done are checked by default in the left tree. To include an 

image in the calculations check the box next to it. To exclude an image, uncheck the box. 
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Description of output data: 

Ǐ Image 

o Group – The name of the group of the image. 

o File name – The image’s filename. 

o Image Resolution – The resolution of the image in µm/pixel. 

Ǐ Quota – This can be selected for Layer 1 - 4 

o LayerX per Total area – The quota of LayerX of the total area 

o LayerX per Diameter – The quota of LayerX of the diameter 

o LayerX per Other Layers – The quota of LayerX of all other layers. 

Ǐ Areas – These areas are given in (µm) 2 thus a non zero resolution for the image is 

required. 

o Area inside outer limits 

Á Calculated as: Image Width * Image Height – Outer Area. 

Á This area also includes what is selected in Artifacts 

o Area of Layer 1 to 4 

o Area of None tissue area 

Ǐ Diameter 

o Longest diameter – The longest distance between two points in the outer 

area selected. 

Ǐ Objects 

o Number of Objects -  The number of objects in chosen layer. 

o Total area of Objects – The total, summed, area of all objects in chosen 

layer. 

o Total area of objects in the Intervals – If any data used with Intervals, this 

gives the total area of objects falling inside the smallest and largest interval. 

NOTE: ¢Ƙƛǎ ƛǎ ƴŜŎŜǎǎŀǊƛƭȅ ƴƻǘ ǘƘŜ ǎŀƳŜ ŀǊŜŀ ŀǎ Ψ¢ƻǘŀƭ ŀǊŜŀ ƻŦ hōŜƧŎǘΩ. 

o Number of Objects in Intervals – The number of objects in each interval. 

o Objects Area in Intervals – This gives the summed area of all objects falling 

inside one interval, for each interval. 

o Relative no. Obj in Intervals – In each interval, the contribution to the total 

number of objects, from this interval. 

o Relative Size in Intervals – As with ‘Relative no. Obj in Intervals’, but in 
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each interval, how much this one contributes to the total area. 

Ǐ Intensity 

o LayerX – The average and total intensity of the pixels selected in the area. 

Ǐ Thresholds – All thresholds used in this project 

Ǐ Flags 

o LayerX – Shows the number of flags in LayerX.  

Results 

 

The result is displayed here. The save button allows the data to be saved to a semicolon 

separated text file which can be imported to Microsoft Excel. 

The Copy button, copies the data to the clipboard, and can then be pasted into an Excel 

sheet. 

To view the flags 

Click on the plus icon to the left of the selected image to expand the table. 
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Click Flag data to jump to the flag data table. The flag table should appear. This is where 

you can see the areas and positions of the different flags you selected. 

 

To navigate back to the data table, simply click the left arrow icon in the blue border. To 

hide/show data from the parent table, click on the rightmost icon in the blue border. 

Importing Data in Excel 

The output data can easily be imported in Microsoft Excel. There are two ways of doing this, 

using the clipboard as an in between medium, or saving to a file. 

Copying to clipboard 

1. Click the Copy button to copy the output data to the clipboard. 

2. Open Excel and select the cell where you want the data to be imported. 

3. Choose Paste from the Edit menu, or press Ctrl+V. 

4. Select ¢ŜȄǘ ǘƻ /ƻƭǳƳƴǎΧ from the Data menu. 

5. Select Delimited in the Import Wizard. 

6. Select Tabs in the next step of the wizard. 

7. Click Finish in the wizard. 

Saving to file and importing 

1. Save data to text file. 

2. Open Excel and choose Open from the File menu. 

3. Select ά!ƭƭ CƛƭŜǎ όϝΦϝύέ in the open file dialog. Choose the data file. 

4. Follow steps 5 to 7 in the above guide copying to clipboard. 
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Copying to clipboard 

Step 1 

Click on the Copy button when the data is shown. The data will be stored in the clipboard 

which we will access from Excel in the next step. 

 

Step 2 

Open Excel and select the cell where you want the data to be imported. 

 

Step 3 

Choose Paste from the Edit menu, or press Ctrl+V. This will read the data from the 

clipboard and put it in the current work sheet in Excel starting at the selected cell. 
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Step 4 

Select ¢ŜȄǘ ǘƻ /ƻƭǳƳƴǎΧ from the Data menu. 

 

Step 5 

In the Excel Import Wizard, select Delimited data. 
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Step 6 

Now select Tab as the separator of data. 

 

Step 7 

Click the Finish button to proceed to the spread sheet. The third step of the wizard is not 

required for the import of the data. 

Your spread sheet should now contain the data, one element per cell. If the data looks 

misplaced repeat the process and make sure the right delimiter is selected and so on. 
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Saving to file and importing 

Step 1 

Click on the Save button when the data is shown. The program will ask you for a file name 

to store the data to. The data will be saved as plain text. 

 

Step 2 

Start Excel and select Open from the File menu. 

 

Step 3 

In the open file dialog, select the file types to be shown as “All Files (*.*)” or type in *.txt to 

display those files with the ending ‘.txt’. 

Select the file to which you saved your data and click on Open. 
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Step 4 

Follow steps 5-7 in the above guide, copying to clipboard, to read about how to convert the 

data to columns in Excel. 
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Colocalization 

For a colocalization calculation two Channels are needed. We call this a Match. A Channel 

can be a Layer in an image, or it can be an image channel such as Red or Green. Typically 

any colour image is stored in such way that it for each pixel has a red value, a green value, 

and a blue value. The red image channel therefore consists of all red values for each pixel in 

the image. If a Match, which consist of two Channels, have channels of different size, a 

result can still be calculated, but only for the region where the two images overlap. This 

area constructed by aligning the top left corner of both images, and then as much of the 

images that overlap. A colocalization is always between 

two Channels. 

To use this tool, add your files or folders as explained 

previously. Then press on the colocalization icon. A new 

column will now appear on the right side. 

To add your folders to this column, just left click on your 

folders and drag them to the new column. You can drag 

several folders to this column at the same time by using 

the Ctrl button and marking all of your folders. 

 

 

If the program chooses the wrong channel for your image, just right click on the channel 

selection and change it to the right channel. 
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A miniature of your images will appear next to them when you have the right channel 

selected. 

TIP: If all images in one column are black, this is an indication that the current channel 

contains no information. Try switching channel. 

 

To see your colocalized image, just double click on the green and red icon . You can now 

see both the green and red channel and your colocalized image on the right side. 
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Results 

To obtain the results, click on the Result’s button. Then select your images for colocalization 

on the left column. For the colocalization calculation, choose colocalization and your 

channels in the right column, as shown in the screenshot below. Then press OK and you will 

have your results. 

 

Description of Output Data 

tŜŀǊǎƻƴΩǎ /ƻǊǊŜƭŀǘƛƻƴ  

[In output: Pearson's Correlation R r ]  

This is a statistical measure that answers the question if channel has a high value at a point, 

does this mean that the other channels have a high value at the same point? This value 

ranges from -1 to 1, where -1 means a negative correlation, where there are red, there is no 

green, and vice versa. 0 means that there is no correlation (using a linear model). 1 means 

the channels are perfectly correlated and all pixels are equal in the channels. The 

calculations take the average value of each channel in account, and therefore the 

‘background’ of a channel does not influence the value of the coefficient. 

In practice only high correlation values, close to 1.0, is used as an indicator for 

colocalization. Lower values is typically really hard to interpret in a biological sense. 

Overlap  

[In output: Overlap Coefficient R]  

This uses no average of the channels and thus the ‘background’ will have effect on the 

result. The values ranges from 0 to 1 where 0 is no overlap. 1 is total overlap. 

Percentage Overlap  

[In output: Percentage Overlap]  

This is the quota of overlapping pixels divided by not overlapping. Similar to Overlap but 

does not account for the values in the points; only overlap or not overlap at any point. This 
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value ranged from 0% to 100%.  

Channel Contribution  

[In output: Channel contribution m 1, Channel contribution m 2]  

This measures the contribution of one channel to the correlation coefficient. m1 – The 

contribution from the second channel. m2 – The contribution from the first channel. The 

values ranges from 0 to 1 where 0 means the channels does not contribute to the 

colocalization. 1 means the channels contributes to all the colocalization.  

Channel Sensitivity  

[In output: Overlap coefficient k 1, Overlap coefficient k 2]  

The value k1 is sensitive to differences in intensity for the second channel while k2 is 

sensitive to differences in intensity in the first channel. k1 – A measure of sensitivity of 

changes in the second channel. k2 – A measure of sensitivity of changes in the first channel. 

The values of these coefficients ranges from 0 to 1 where 0 means the colocalization does 

not depend on the channel. 1 means the colocalization depends only on the channel.  

Area Colocalized  

[In output: Overlap Area in pixels]  

The colocalized area in pixels and µm (if a resolution is set to the images from which the 

channel is taken) 

Pixel area of Channel One/Two 

[In output: Pixel Area of Channel One, Pixel Area of Channel 

Two]  

The area in each channel of pixels where the value is larger than zero. I.e. where there are 

signal, or material, in the image. 

  



   

BioPix iQ 2.0 User Guide  

 

BioPix iQ User Guide / Rev 4/ 2008-06-03  32/29 

3D 

The 3D plugin is an optional feature shipped with BioPix iQ 2.0. This chapter describes the 

features of it. To use it, it must first be installed and activated. 

General Concepts 

The 3D plugin supports visualization and quantification of volumetric data, formatted as 

lists of images. Such an image is in the 3D plugin called a slice, and the list of slices defining 

the volumetric data is called a stack. The stack then defines the orders and thicknesses of 

all slices. If the sizes (width and height) of the slices within a stack are different, the slices 

are scaled to use the same size as the slice with the maximum width and height. The 

resolution of the stack in x- and y-dimensions is automatically set to match the resolutions 

of the slices within the stack; if all slices have the same resolution, the resolution of the 

stack is set to this value, but if they have different resolutions, the resolution is not updated 

and a default resolution of 0.1 µm/px is used. To then define what area to present in 3D, a 

list of layers is defined, identifying what pixels are interesting and what are not. Two types 

of layers exists; one using the layers from 2D and one based on HSB settings. 

The plugin also supports visualization and quantification of colocalization of stacks. This is 

done by selecting the layers that define the materials to colocalize. The different channels 

are then visualized together, and different colors can be applied on them in order to 

visually separate them. 

Stack  A “3D image” consisting of a number of slices. 

Slice  Am image representing 3D data in one XY plane. 

Setup 

 To setup the 3D plugin, the installation of BioPix iQ 2.0 with the 3D plugin included must be 

acquired from BioPix AB. With this installation file, following the steps described in the 

Installation chapter found on page 5, will install the plugin. 

When the 3D plugin has been properly installed with 

BioPix iQ 2.0, the plugin must be started. This is done 

by clicking on the menu item Plugins and then on 3D 

(Click to start).  

 

When the plugin has been started, the status of it, 

shown in the parentheses, should have changed to 

from Click to start to Running, and a new panel with 
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the title 3D should appear below the File List. 

To be able to run the 3D plugin, appropriate license is needed. If the license to run the 

plugin is acquired after the activation of BioPix iQ, a re-activation might be needed. 

Following the instructions for program activation if this is necessary. 

If, somehow, the 3D device could not be initialized, a message will appear informing you of 

this. The 3D Preferences dialog (see chapter below) will then appear letting you setup the 

3D device so that it can be initialized. If you press Cancel here, the plugin will not be able to 

start and will thus be stopped. 

User Interface 

The 3D interface introduces some new areas to BioPix iQ, but mostly resembles the layout 

used in BioPix iQ. To the left, below the File List, a 3D panel (1) is added where stacks of 

slices and colocalizations are created and organized into 3D projects. In the middle, the 

currently selected slice (if any) is shown (3), and below this a 3D view (2) of the currently 

selected stack or colocalization is present. To the right, tools for working with the stack or 

colocalization and the 3D view are located (4). 

 

1. The Stack View lists stacks and colocalizations arranged into projects. 

1 
2 

3 4 
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2. The 3D View presents a 3D projection of the currently selected stack/colocalization. 

Two modes are possible – Preview, were a preview of the active 

stack/colocalization is presented, and Generated Scenes, were fully generated 

scenes are shown. 

3. The Slice View is used to show the currently selected slice. Any material selected by 

a layer or a HSB-channel (described later) is shown. If no slice is selected, then this 

panel is hidden. 

4. The Tools panel show different tools depending on if currently in Preview mode or 

in Generated Scenes mode. In Preview mode, tools for setting up the current 

stack/colocalization and generating scenes are presented. In Generated Scenes 

mode, tools for managing scenes generated are presented. 

Stack View 

When the 3D plugin has been started, the stack view is 

shown below the file list. This is where you begin. Click 

on the title row of the view to hide or show it. Below this title row, an action panel with 

buttons is shown, and below this a tree of projects, stacks, slices, colocalizations and 

channels is shown. These different parts are descibed below. 

Action Panel 

To manage the stacks and colocalizations, five buttons 

exists to control the creation and removal of them. To 

get better organization of the stacks and colocalizations 

created, they are grouped into 3D projects, or simply 

projects. A project can hold any number of stacks and colocalizations. 

To create a project, click Add Project. A project, automatically named Project1 (next project 

is named Project2, and so on), is added to the stack view. This naming rule is used for stacks 

and colocalizations also. To rename a project or stack, right-click on the item you want to 

rename, change the name in the textbox and press enter to confirm the name change. 

To add a stack to a project, select the project you want the stack to be added to, and click 

Add Stack. The stack is added to the selected project, and automatically named Stack1, but 

can also be renamed in the same way as when renaming a project. 

To add a colocalization, select the project where you want the colocalization to be added 

and click Add Coloc. The Setup Colocalization dialog is shown. 



   

BioPix iQ 2.0 User Guide  

 

BioPix iQ User Guide / Rev 4/ 2008-06-03  35/29 

 

In the first field, under Name of colocalization, enter the name of the colocalization you are 

going to create. Below, under Browse for Channels, a tree of possible channels to use is 

shown. To add a channel to the colocalization, either drag it from this list down to the 

Selected Channels list, or select it and click Add. When a channel is added to the 

colocalization, it is shown in the list named Selected Channels, and also removed from the 

list of possible channels to use because it cannot be used again in this colocalization. To 

remove a channel from being used, select it and click Remove. When pleased with the 

setup of the colocalization (can be changed later) click Ok to confirm the setup of the new 

colocalization and to add it to the selected project. To close the dialog without adding a 

colocalization, press Cancel. When a colocalization has been added to the Stack View, the 

selected channels in it are shown in the Stack Tree if the colocalization is expanded. 

When a stack has been created, select the images and/or groups in the File List to add, 

select the stack to add them to, and finally click Add Images to add the selected images to 

the selected stack as slices. 

To remove projects, stacks, slices, colocalizations and channels, select the ones you want to 

remove and click Remove. A dialog appears asking if you are sure you want to delete them. 

Click Yes to confirm the removal of them, or No to cancel. It is also possible to click the 

delete key to remove the selected items. 

Stack Tree 

The stack tree shows a tree of projects, stacks, slices, 

colocalizations and channels. To expand or collapse a node 
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in this tree, simply click on the  or  icons to the left of the name. 

To activate a node, simply double click on it and it will appear in the 3D View and/or Slice 

View. The Slice View will only appear if double clicking on a slice, otherwise this view is 

hidden. Double clicking on a project will do nothing. 

By right clicking in the stack tree different context menus will show, depending on what 

node is being clicked. 

Every node in the tree can also be dragged around. It is for example possible to rearrange 

the slices in a stack by selecting the slices you want to move, and dragging them to where 

you want them. Stacks and projects can be moved around similarly. It is also possible to 

drag images from the File List to the stack tree by simply selecting the images or groups you 

want and drag them down to where you want them in the stack tree. 

Empty Space 

Right clicking on an empty space will only allow for one action; 

Add Project which will add a new project.  

Dropping images on this area will create a new project and a new stack and assign the 

images to that stack. Dropping groups of images will create a new project and one new 

stack for each group being dragged. Dropping groups of groups of images will create one 

new project for each first level group, and then in each project one new stack for each sub 

group is created, holding the images in that group. 

Project 

Right clicking on a project will open a menu where it is 

possible to add stacks by clicking on Add Stack, to add 

colocalizations by clicking on Add Coloc, to rename the 

project by changing the name in the textbox and pressing 

enter, and to remove the project by clicking Remove. 

Dropping images on a project will create a new stack and add 

the images to it. Dropping groups of images on the project will create one new stack for 

each group and put them in the project. 

Stack 

Right clicking on a stack will enable a new action Show, which will activate the stack (the 

same effect as double clicking on it). This action will appear when right clicking on slices and 

colocalizations as well. Add Selected Images will add any 

selected images and/or groups in the File List to the 

selected stack. As when right clicking on a project, it is 

possible to rename and remove a stack. 

Dropping images, or groups of images, on a stack 

appends them to that stack. 
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Slice 

Right clicking on a slice will add a new action Edit which will 

open up the 3D View of the stack holding that slice and the 

Slice View showing selections made on it, but also show the 

original 2D tools panel containing the Image Tools, Drawing 

Tools, Auto Tools and Layers. From here you can manually 

edit the layers using these tools. It is also possible to double 

click on the slice when it is already shown in the Slice View to change the tools panel from 

3D tools to the 2D tools, and vice versa. 

Note that when editing a slice, the Slice View will only show those layers that are used by 

the stack, and no others. So, if activating another layer, for example the Outer layer if this 

layer is not used by the stack, and then drawing something on it using the Drawing Tools or 

Auto Tools, nothing will show. 

Images or groups cannot be dropped on a slice, but dropping them just before or after a 

slice will append the images to that position. It is also possible to copy slices by dragging 

them and holding Ctrl when dropping them. This will create copies of the same slices being 

dragged. 

Colocalization 

Right clicking on a colocalization will show a similar menu as 

for the slice, but clicking on Edit will show the Setup 

Colocalization dialog described on page 34. It is also possible 

to rename and remove the colocalization. 

 

Channel 

Right clicking on a channel in a colocalization will only allow for one 

action Remove, which removes the channel from being used in that 

colocalization. 

File List 

Right clicking somewhere on the file list, a new 3D menu will appear last in the menu. 

 

Hold the mouse over this menu item to open the sub menu of 

3D. Note that these are only enabled if at least one group or 

image is selected, and if they are structured in a way possible 

to automatically convert. An invalid selection would for 

example be if selecting a group and a slice in that group at the 

same time, as the slice is implicitly used as it belongs to that 
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group. 

 

 

 

 

Add to new stacks with fixed size can be used to add the selected images/group with 

images and add them to new stacks, with each stack 

holding the specified number of slices. Hold the mouse 

over this item to show a list of predefined sizes, and a 

textbox where you can enter any valid number to use as 

fixed size. To use a predefined size, simply click on its 

name. To use another size, click on the textbox and 

change the number to the number of slices you want in each stack, then click enter to 

confirm. If the number is valid (i.e. no letters), the specified size will be used, and then this 

size is added to the predefined sizes to be used later. If no project exists, one will be 

created where the stacks are added. If only one project exists, this project will be used, but 

if more than one projects exist, the Select 3D Project dialog appears where you can select 

what project to use (this dialog is described in more detail later in this chapter). If a group is 

selected then all images belonging to that group and any subgroup of it will be used. To 

clear all previously used sizes, click Clear Predefined Sizes. All predefined sizes will be 

removed, and new can be entered by using the textbox. 

Convert to can be used to convert the selected images or groups to 3D representations. It is 

for example easy to convert a group of images to a stack of 

slices, or to convert a group of groups of images to a project of 

stacks of slices.  

 

Click New Project to convert the selected groups or images to projects, automatically 

creating new projects and stacks if needed.  

Click New Stack to convert the selected groups or images to stacks and add them to a 

project. If no project exists, then one will be automatically created and used. If only one 

project exists, then this one will be used. If more than one project exists though, a Select 3D 

Project dialog appears where you select what project to put the stacks in. Select the project 

you want and click OK, or click Cancel to abort. To add a new project, click New Project. 
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Click Slices in Stack to convert the selected group or images to slices in a specific stack. If no 

stack exists, a new stack will automatically be created and used. If only one project and 

stack exists, this stack will be used. If more than one stack or project exists, the Select Stack 

dialog will appear. In this dialog you browse for the stack you want, and click OK when you 

have selected it, or Cancel to abort. Click New Project to add a new project, and New Stack 

to add a new stack to the currently selected project. 
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3D View 

 

The 3D View presents the 3D projection of the scene generated from the currently 

activated stack or colocalization. Two modes are possible here; Preview and Generated 

Scenes. By clicking on their respective tabs, they will be activated. Above the tabs a title 

row naming the current stack or colocalization that is being rendered can be found.  

Navigation 

To navigate in the 3D View there are three mouse combinations to use. Press and drag left 

mouse button to rotate, press and drag right mouse button to pan and press and drag both 

left and right mouse buttons to zoom in and out. 

Context Menu 

Right clicking in the 3D View will open up a context menu 

showing three options. The checkmark to the left of each option 

indicates that an option is enabled, and by left clicking on each 

option they can be enabled and disabled. With Perspective 

disabled (see the left image below), the 3D model will be projected orthogonal and a grid 

and scale is shown (if checked). With Perspective enabled (see the right image below) the 

current projection will use a perspective to get a depth feeling. Show Grid will show a grid 

of 2 µm in spacing, and Show Scale will show a scale in the upper left corner. These two 

options are only available with Perspective turned off. 
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Preview Mode 

In preview mode, only a preview of the final projection will appear. The detail bar in the 

bottom decides what detail level to be used when generating the 3D model. A lower detail 

(when slider is moved to the left) is faster to generate but produces less detailed images. A 

higher detail (when slider is moved to the right) takes longer time to generate but produces 

higher detailed images. To the left of the slider a detail percentage number is present. This 

number decides how many percent of the original width and height of the 

stack/colocalization that is being used when generating the preview. If for example a stack 

of 16 slices of 1024*1024 pixels in size, and 10% detail, is used, the slices will be 

compressed to 102*102 pixels, which is approximately 100 times faster to generate than if 

generating at 100%.  

 

Every time the slider is moved, the 3D model is automatically regenerated, and when being 

generated a progress bar appears in the top showing the current progress of the 

generation. This bar needs to finish twice for each layer that is used in the current 

stack/colocalization before the generation can complete. 

 

Generated Scenes 

In generated scenes mode, only scenes that 

are generated using the Generate button 

(described on page 45) are shown. In this 

mode it is possible to select 3D objects and 

gain information about them using the 

Object Information panel (described on 

page 46). To select an object, click on it with 

the left mouse button. A blue, semi-

transparent, box will appear around the 
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selected object. To select several objects at the same time, hold Shift and click on the 

objects you want to select. To deselect all objects, click on an empty area with the left 

mouse button. 

Slice View 

 

The Slice View is used to see a slice and its areas selected by the layers. Only selections 

from layers that are used in the current stack are shown, and layers that are not added to 

the stack, or that are not in use, are not shown at all in this view. The pixels automatically 

selected by a HSB layer will also be shown in this view. 

Tools 

Depending on in Preview mode or in Generated Scenes mode different tools are shown, 

described in this chapter. Because the Render Control is present for both modes, this is 

described in the chapter Common Tools, while the other tools present when in Preview 

mode and Generated Scenes mode are described in their specific chapters. 

Common Tools 

These controls are common for both the Preview mode and Generated Scenes mode. 

Render Control 
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The Render Control is responsible for setting up the 3D 

View. By clicking on the color right to Background color and 

Grid color a color selection dialog appears where you can 

change the color of the background and grid. The  and 

 does not do anything. {ŀǾŜ LƳŀƎŜΧ will let you save a 

screenshot image of the 3D View to a file. A Save As dialog 

will appear where you can choose where to save the file 

and in what format – PNG, BMP or JPEG. Reset View will 

reset the navigation of the 3D View to a default view, useful for quickly zooming out. 

Preview 

The following tools, including the Render Control, will appear when in Preview mode. 

Resolution of stack/colocalization 

These tools let you setup the resolutions of stacks and 

colocalizations. The resolution Res is the resolution of all 

slices in that stack or colocalization, and is automatically 

updated to match the resolutions of the slices. The slices 

must have the same resolutions, or the resolution of the 

stack/colocalization cannot be automatically decided. The 

Slice thickness controls how thick each slice in the stack or 

colocalization is. Use  to change the thickness up and down by a step of 0.1 µm. 

Layers (stack specific) 

The Layers panel, only shown when a stack is activated, 

lets you setup the layers that define what areas to use 

when constructing the 3D model. Two different layers 

exist; HSB layers and normal layers, and two different 

dropdown buttons to add these can be found in the top of the layers panel. Below these 

buttons a list of all layers mapped to the active stack can be found.  

The icon to the left of a layer identifies the layer either as a 

HSB layer  or a normal layer . If it is colored  then 

it is used, and if gray  then unused. To change state 

between used to unused, simply click on the icon. Only used layers are used when 

constructing the 3D model. To remove a layer completely, click on the trashcan . For 

more settings specific for a layer, click on its name or the arrow to the right to expand or 

collapse the layer specific settings. 

HSB Layers 

The HSB layers automatically filter each slice in the stack 
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according to user specified HSB settings. To add a HSB layer click on Add HSB, enter a name 

of the new layer (default name is HSB 0, HSB 1…) and press enter. A new HSB layer will 

appear in the list of layers. A layer that is already added to another stack can be reused in 

this stack by clicking on that layer in the drop down list. Any change in this layer will also 

update that layer in the other stack, but the colors of them can be different. 

Click on the layers name to open up the HSB specific 

settings for that layer. Color sets the color that is used in 

the 3D View and in the Slice View. Click on the color 

square to change to another color, and click on  and  

to increase and decrease the transparency used in the 3D 

View. Using a semi-transparent color can be useful if using 

several layers at the same time.  

To setup the HSB settings please refer to Select by HSB on 

page 13.  

wŜƳƻǾŜ [ŀȅŜǊΧ will remove this layer completely from any 

stack using it and not make it possible to reuse again by 

clicking on Add HSB. Clicking on the trashcan  only 

removes the layer from being used by this stack, but the layer can still be added again by 

selecting it after clicking on Add HSB. 

Normal Layers 

The normal layers are mapped to one of the layers Outer, 

Artifacts, Not Tissue, Layer1, Layer2, Layer3 and Layer4. Use these 

if you have selected the material manually using the drawing tools 

or auto tools. To add a layer click on Add Layer and then click on 

the layers name in the dropdown list. When a layer has been 

added, the icon left to its name in the dropdown list will become 

gray, and it is thus not possible to add again to the same stack. 

When the layer has been added it 

will appear in the list of layers. Clicking on its name will 

open the layer specific settings, from where it is possible 

to change the color of that layer by using the control 

next to Color. 

Coloc Channels 

The Coloc Channels are the control used to setup the 

channels used by a colocalization. A channel is simply a 

layer, but called channel in the context of colocalizations. 

The button panel shows two buttons Add Channel which 

will add a channel to this colocalization, and Edit Setup 
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which will open the Setup Colocalization dialog described on page 34. Below these buttons 

a list of the channels used is shown, including a colocalization specific channel called Coloc, 

which will always select the area colocalized by all other channels. 

Clicking on Add Channel will open the Select 

Stack Channel dialog which will let you select 

what channels to add to the colocalization. 

Only channels that are not already used are 

shown in this list. Brows in the stack tree to 

select the channels you want to use, and click 

OK when you have selected the channels you 

want. Press Cancel to close the dialog without 

adding any channels. 

 

The colors of the channels, and HSB settings of a HSB layer, can be changed in the same 

way as in the Layers tool. 

Edit Slice 

Edit Slice is only visible if a slice is active and the Slice View 

is shown. Click this button to activate the slice edit mode 

where the preview tools panel will be replaced by the original 2D tools, making it possible 

to edit the slice. To get back to the preview tools panel after activating the slice edit mode, 

simply double click on that slice again. 

Generate 

Generate is a very important button. When you have 

finished setting up the stack by adding the correct slices, 

setting the slice thickness and adding the layers you want, and the Preview view shows an 

acceptable image of the selected materials, then click this button to start generate a full 

detailed scene of the stack or colocalization. 

A new tab, DŜƴŜǊŀǘƛƴƎ ǎŎŜƴŜΧ, will appear 

next to Generated Scenes. This page will 

show the current progress of the 

generation. Overall indicates the overall 

progress, when this reaches 100% the whole 

generation is complete. Current Operation 

indicates how long the current operation 

has progressed. Estimated Time Left 

approximates the time left to generate the 

scene. The Progress History shows a list of 

operations completed in black and the current operation in green. Press Abort to cancel the 
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generation. When the generation is complete, the Generated Scenes tab will be activated, 

and a scene will be presented. This scene will contain nodes, one for each layer used in the 

generation, called scene nodes.  

Generated Scenes 

The following controls are shown when in Generated Scenes mode. 

Filters 

The filters can be used to filter out small objects when 

rendering. Set the Min volume to the minimal volume in 

µm3 that an object must be off to be rendered. 

Coloring 

Coloring defines how to render the objects. Color by 

object renders the object with random colors for each 

object, which makes it easy to separate the objects from 

each other. Color by layer will color the objects with the 

same color as the layer they were created from, useful for 

identifying what layer the objects originates from. 

Object Information 

The Object Information gives back information about the 

currently selected objects (selected by clicking on them in 

the 3D View). The Number of Selected Objects identifies 

how many objects that are selected, and Volume outputs 

the total volume of the selected objects in µm3. 

Render Selection 

In this control you select what scene nodes to render in the 3D View. The scene nodes that 

are marked with a checkmark  left to them, in the Name column, are rendered with the 

color shown in the Color column. By clicking on the 

squares left to the name of the project, stack, scene or 

scene node, the render state can be changed.  identifies 

a node that is being rendered,  identifies a node that is 

not rendered and  identifies a node where some of the 

scene nodes of it are rendered and some are not. 

By clicking on the color square, it will change to a color 

selection control  letting you change the color of 

that scene node, which will change the appearance of the 

3D View if Color by layer is used. 
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Results 

The Results button is used to quantify the results from the 

generated scenes. The Specify Results dialog will appear 

when clicking this button, letting you decide what to quantify. 

 

To the left, under Select Scene, select the layers that contain objects that you want to 

quantify. To the right, under Select Output, select the type of data you want to quantify. 

Click Calculate Results to start the calculation. Click Cancel to close the dialog without 

calculating anything. 

The following types of data are possible to select in the Select Output tree. 

¶ Info 

o Project – The name of the project that holds the stack that the scene node 

was generated from. 

o Stack – The name of the stack that the scene node was generated from. 

o Scene – The name of the scene (automatically named) generated. 

o Node – The scene node (layer) to quantify. 

¶ Volume 

o Total volume – The total volume of all objects in this scene node. 

o Average volume per object – The total volume divided with the total 

number of objects. 

¶ Number of objects 

o Total number – The total number of objects in this scene node. 

o Volume Distribution – Writes the number of objects found in different 



   

BioPix iQ 2.0 User Guide  

 

BioPix iQ User Guide / Rev 4/ 2008-06-03  48/29 

volume intervals. When starting to calculate, the Setup Volume Distribution 

dialog will appear, letting you setup the intervals. 

 

Use Start Volume to set the minimum limit of the smallest interval. Check 

Sum objects up to smallest interval to sum the volumes of the objects 

having volumes below the Start Volume, and then divide this by the Start 

Volume to approximate the smaller objects as objects having a volume 

within the smallest interval. 

Interval Volume controls how many intervals to create. Select Number of 

Intervals and enter the number of intervals in the textbox to the left to 

explicitly set the number of intervals that should be created. Each interval 

will then have a volume step of: 

ὠέὰόάὩ έὪ ὍὲὸὩὶὺὥὰί=
ὓὥὼ ὠέὰόάὩ Ὓὸὥὶὸ ὠέὰόάὩ

ὔόάὦὩὶ έὪ ὍὲὸὩὶὺὥὰί
 

Select Volume of Intervals and enter the volume step in the textbox to the 

left, to explicitly set the volume in µm3 that each interval will step over. The 

number of intervals created will then be: 

ὔόάὦὩὶ έὪ ὍὲὸὩὶὺὥὰί=
ὓὥὼ ὠέὰόάὩ Ὓὸὥὶὸ ὠέὰόάὩ

ὠέὰόάὩ έὪ ὍὲὸὩὶὺὥὰί
 

Max Volume sets the maximum limit of the largest interval. Check Split 

larger objects to smaller to split the objects having volumes above this limit 

into smaller objects and include these smaller objects in the largest interval. 

Check Use Infinity as upper bound to include all objects above Max 

Volume in the largest interval as well. 

Click OK to continue with the quantification. Click Cancel to abort. 

When the calculation is done the Show Results dialog will appear. Please refer to Results on 

page 21 for a description on how to use this dialog. 
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3D Preferences 

When the 3D plugin has been started, a new menu item, 3D 

Preferences, will be added to the Edit menu. Click on it to 

open the 3D Preferences dialog. 

 

 

Direct3D Settings controls how the Direct3D device is created (This is the software 

component that uses the computers 3D hardware to render 3D images). The default 

settings shown above should work in most cases. Only change these settings if the 

rendering currently does not work, or cannot be initiated. 

¶ Device Type – Specifies a device type. 

o Hardware (default) – Hardware rasterization. Shading is done with 

software, hardware, or mixed transform and lighting. 



   

BioPix iQ 2.0 User Guide  

 

BioPix iQ User Guide / Rev 4/ 2008-06-03  50/29 

o Software – Microsoft Direct3D features are implemented in software; 

however, the reference rasterizer uses special CPU instructions whenever 

possible. 

¶ Vertex Processing 

o Mixed (default) – Specifies mixed vertex processing (both software and 

hardware). 

o Hardware – Specifies hardware vertex processing.  

o Software ς Specifies software vertex processing. 

¶ Disable Driver Management 

o Disabled (default) – Specifies that resources be managed by the driver. 

o Enabled ς Fail on resource errors – Specifies that resources be managed by 

Direct3D instead of the driver. Direct3D calls will fail for resource errors 

such as insufficient video memory. 

o Enabled ς 5ƻƴΩǘ Ŧŀƛƭ ƻƴ ǊŜǎƻǳǊŎŜ ŜǊǊƻǊǎ – Specifies that resources be 

managed by Direct3D instead of the driver. Direct3D calls will not fail for 

resource errors such as insufficient video memory. 

¶ Pure Device - Specifies that Direct3D not support Get calls for anything that can be 

stored in a state block. Also instructs Direct3D to withhold emulation services for 

vertex processing, which means that if the device does not support vertex 

processing, the application can use only post-transformed vertices. 

Press Apply Now to apply the Direct3D settings directly, instead of using the OK button 

which will close the dialog if the settings could be used. A message will appear informing 

you whether the settings could be applied or not. 

Saving controls whether to save the generated scenes or not. As they often contain lots of 

data, they make the project file grow in size, which is why saving them is optional. A typical 

scene generated could for example take 20 Mb to store. 

¶ 5ƻƴΩǘ ǎŀǾŜ ƎŜƴŜǊŀǘŜŘ ǎŎŜƴŜǎ όŘŜŦŀǳƭǘύ – Will not save the scenes generated, and 

any project loaded with generated scenes will be stored without these scenes if 

saved. 

¶ Save generated scenes – Will store any generated scene in the project file when 

being saved, which will make the project file larger in size. 

Reset to Default will reset all settings to their default values. Note that this will also reset 

the predefined fixed sizes (see page 38). Click OK to apply any changes in the Direct3D 
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Settings, save them and close the dialog. If the Direct3D settings could not be applied, an 

error message will appear, and the dialog will not be closed. Click Cancel to abort all 

changes, and to close the dialog without saving. 

 


